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Questions
If you have questions, see How to Get Help.

KB numbers
A number with the prefix "KB" next to an item in this readme, such as KB49909, 
refers to a Knowledge Base article published by Opto 22. A KB article provides 
additional information about a feature or bug. To find a particular KB article, 
go to the Opto 22 website, http://www.opto22.com, and enter the KB number in the 
search engine. To browse the entire list of KB articles, go to 
http://www.opto22.com/site/documents/kbarticles.aspx.

Version 7.1 of Opto 22’s ioProject software suite now supports the SNAP-PAC-R1 
and SNAP-PAC-R2.

General Note about Windows XP: 
If you run ioProject applications in Microsoft Windows XP, make sure to use the 
Windows Classic theme. Otherwise, a Microsoft bug with how themes are handled 
may cause the system to crash.

To correct the problem:
1. Right-click on an empty part of the Desktop.
2. Select Properties.
3. With the Themes tab selected, choose the Windows Classic theme.
4. Reboot to get a clean start.

------------------------------
For ioProject Version R7.0006 (January 12, 2006):

Now you can install both ioProject Professional and ioProject Basic on the same 
computer.

------------------------------
For ioProject Version R7.0000 (December 12, 2005):

What's New in ioProject 7?

Version 7.0 of Opto 22’s ioProject software suite for industrial automation,
remote monitoring, and data acquisition applications introduces two forms of
the software suite: ioProject Basic and ioProject Professional.  Additional
major changes in this version include support for new SNAP PAC controllers.

ioProject Basic
---------------
ioProject Basic provides ioControl Basic for developing control programs, or
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strategies, and ioDisplay Basic for developing operator interfaces (HMIs).
ioManager software is also included for configuration.

ioProject Basic comes with your purchase of a SNAP PAC or SNAP-LCE controller,
or a SNAP Ultimate, SNAP Ethernet, or SNAP Simple brain. It can also be
downloaded from our website, www.opto22.com. Full documentation is provided in
Adobe Acrobat PDF format.

ioProject Professional
----------------------
ioProject Professional includes ioControl Professional for developing control
strategies, ioDisplay Professional for developing operator interfaces (HMIs),
and OptoOPCServer for communicating with OLE for Process Control (OPC) 2.0
clients. ioManager software is also included for configuration.

ioProject Professional is designed for more complex projects, especially those
requiring OPC, multiple protocol, multiple network, or legacy hardware support.
ioProject Professional is designed for use with SNAP PAC controllers and takes
advantage of their features, including dual independent Ethernet network
interfaces for redundant Ethernet links or segmented networking.

ioProject Professional can be purchased as a complete suite or as individual
applications. It can be downloaded from our website for immediate use and is
also shipped to you on a CD with full documentation in both PDF and printed
form.

Information in this README file applies to both versions of ioProject unless 
otherwise indicated with [BAS] or [PRO].

ioControl
Version R7.1e 
(October 23, 2006):

New Features:
-------------

Added the following conditions:
    Bit Off in Numeric Table Element?
    Bit On in Numeric Table Element?

Bug Fixes:
----------

* (KB51958) A problem has been resolved where in Action blocks, the "Convert 
Number to Formatted Hex String" and "Convert Number to String Field" commands 
did not work properly when an Integer 64 was passed in.

"Convert Number to Formatted Hex String" will work in PAC products, but there is 
a different bug in the UIO firmware which causes incorrect results regardless of 
this ioControl bug fix.

* (KB52178) A problem as been resolved where the following OptoScript commands 
could cause a control engine to reset or have other strange behavior if an 
Integer 64 was passed to any of the parameters named "Module #", "Point #", 
"Start Index", "Start Table Index", or "Clear Mask".
    GetHddModuleStates
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    GetHddModuleOnLatches
    GetHddModuleOffLatches
    GetClearHddModuleOnLatches
    GetClearHddModuleOffLatches
    GetAllHddModuleStates
    GetAllHddModuleOnLatches
    GetAllHddModuleOffLatches
    GetClearAllHddModuleOnLatches
    GetClearAllHddModuleOffLatches
    ClearHddModuleOnLatches
    ClearHddModuleOffLatches
    SetHddModuleFromMomo
    TurnOnHddModulePoint
    TurnOffHddModulePoint
    GetHddModuleCounters
    GetClearHddModuleCounters
    GetClearHddModuleCounter

* (KB52680) A problem has been fixed where ioControl could crash if all of the 
following conditions were met:

+ The Configure->Options...->Debugger->"When stepping, make sure the active 
block is visible" option was set.

+ ioControl was in Debug mode and the loaded strategy was running.
+ The loaded strategy had large charts that were closed.
+ The Find dialog was used to find something.

* (KB52544) A memory leak when using the Find dialog has been fixed.

* (KB53999) A problem has been fixed where an ioControl archived
strategy stored to the control engine did not survive a power cycle.

------------------------------
For Version R7.1d 
(May 4, 2006):

Information in this README file applies to both versions of ioControl
unless otherwise indicated with [BAS] or [PRO].

NOTE: See the release notes for the SNAP controller firmware for
changes at the firmware level.

Bug Fixes:
----------

* (KB51461) A problem has been fixed where ioControl would become unresponsive 
after removing a variable from two or more charts and then deleting the 
variable. The next time the strategy was saved (either manually or automatically 
as the result of another user action), ioControl would become unresponsive and 
have to be terminated manually by the user.

* (KB51393) A problem with exporting charts has been resolved. Items only within 
OptoScript blocks were sometimes not exported. The behavior would depend upon 
the exact nature of the chart.
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------------------------------
For Version R7.1c 
(April 20, 2006) :

Bug Fixes:
----------

[PRO] 
* (KB51055) Corrected a problem with inspecting pointer tables that were passed 
parameters in a subroutine. Opening the inspect dialog would cause a -12 
"Invalid table index" error to be put into the control engine's message queue.
  
* (KB51159) Corrected a problem with inspecting PID loops. When double-clicking 
on a PID folder in the strategy tree, the I/O unit inspect dialog would 
incorrectly show the list of points and not the PID loops.

------------------------------
For Version R7.1b 
(April 7, 2006) :

Bug Fixes:
----------

[BAS]
* (KB50851) A problem has been fixed where the following commands did not allow 
counters from the SNAP-PAC-R1 or SNAP-PAC-R2:
    Clear Counter
    Get & Clear Counter
    Start Counter
    Stop Counter

[PRO]
* (KB50824) Problems with moving a point on a B3000 Analog brain have been 
corrected. In some situations, ioControl did not allow a point to be moved to 
all available positions. In other situations, it incorrectly allowed a point to 
be moved into a module with a different measurement type (e.g. moving a voltage 
input into a current input).

------------------------------
For Version R7.1a 
(March 8, 2006) :

New Features:
-------------
Added support for SNAP-PAC-R1 and SNAP-PAC-R2.

Enhancements:
-------------
٭ Added the following commands:

  Set I/O Unit from MOMO Masks
  IVAL Set I/O Unit from MOMO Masks
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These commands will work for all I/O units that allow digital points. They 
replace and deprecate the following commands:

  Set Digital I/O Unit from MOMO Masks
  Set Digital-64 I/O Unit from MOMO Masks
  Set Mixed I/O Unit from MOMO Masks
  Set Mixed 64 I/O Unit from MOMO Masks
  Set Simple 64 I/O Unit from MOMO Masks
  IVAL Set Digital Binary
  IVAL Set Digital-64 I/O Unit from MOMO Masks
  IVAL Set Mixed I/O Unit from MOMO Masks
  IVAL Set Mixed 64 I/O Unit from MOMO Masks
  IVAL Set Simple 64 I/O Unit from MOMO Masks

These old commands will continue to work. They have been moved to a new group 
called "Deprecated".

٭ The generic names for I/O units have been replaced with the actual part 
numbers.

    OLD NAME                            NEW NAME
    ------------------------------------------------------------------
    SNAP Mixed Ultimate I/O             SNAP-UP1-ADS
    SNAP Mixed 64 Ultimate I/O          SNAP-UP1-M64
    SNAP Mixed 64 Simple I/O            SNAP-ENET-S64
    SNAP Mixed Ethernet I/O             SNAP-B3000-ENET, SNAP-ENET-RTC
    SNAP D64 Ultimate I/O               SNAP-UP1-D64
    SNAP D64 Ethernet I/O               SNAP-ENET-D64
    B3000 SNAP Digital                  B3000 (Digital portion)
    B3000 SNAP Analog                   B3000 (Analog portion)
    SNAP Remote Simple Digital          SNAP-BRS
    G4 Digital Multifunction I/O Unit   G4D16R
    G4 Digital Remote Simple I/O Unit   G4D32RS
    G4 Analog Multifunction I/O Unit    G4A8R, G4RAX
    B100 Digital Multifunction I/O Unit B100
    B200 Analog Multifunction I/O Unit  B200

Bug Fixes:
----------

٭ (KB49830) A problem has been fixed where in very rare circumstances, 
ioControl would crash when opening inspect windows in debug mode.

  
٭ (KB50224) A problem has been fixed where numeric or string tables that were 

in a watch window and expanded would cause errors if the table's name had 
been changed. This could potentially prevent switching to debug mode.

------------------------------
For Version R7.0d 
(January 19, 2006) :

Bug Fixes:
----------
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٭ A problem has been fixed where the Output Maximum Change for any existing PID 
Loops would change to 0 when opening a pre-7.0 strategy.

٭ A problem has been fixed where the Replace function would not work correctly 
if an OptoScript block had lines that ended with just a newline character, 
not the normal Windows carriage-return and newline pair. This was most likely 
to happen if OptoScript code was copied from another program, like an email 
client.

٭ A problem has been fixed where a chart was not marked as being modified and 
needing to be compiled when using the Replace function and changes to the 
chart only occurred in OptoScript blocks.

------------------------------
For Version R7.0c 
(January 1, 2006) :

Bug Fixes:
  ----------

[PRO] (KB49424) The "Set Analog Load Cell Fast Settle Level" and
  "Set Analog Load Cell Filter Weight" commands change to the "Set All
  Target Address States" and "Get Target Address State" commands,
  respectively, when OK is clicked from the Add Instruction dialog
  window. Also, the code will not compile.

------------------------------
For Version R7.0b 
(January 22, 2005) :

  Bug Fixes:
  ----------

  [PRO] ioControl would crash when opening an OptoControl
  strategy that called a subroutine.

  When exporting I/O units, it was possible that the incorrect
  IP address would be written to the OTG file. This was most
  likely to happen after previously importing the configuration
  from an ioManager-generated OTG file.

------------------------------
For Version R7.0a 
(December 19, 2005):

  New Features:
  -------------

  [PRO] Added the ability to import OptoControl strategies.

  [PRO] Added support for serial mistic brains.

  [PRO] Added secondary target addresses for Ethernet-based
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  I/O units.

  [PRO] Added I/O units, digital points, analog points, and
  pointer tables as possible passed-parameter types for
  subroutines. Pointer variables were added as a possible
  local variable type for subroutines.

  Added support for the following modules (see also R6.1c):
    SNAP-AIARMS-i
    SNAP-AIVRMS-i

  Enhancements:
  -------------

  Added an option to control if the active block is always visible
  when stepping through a chart. The behavior was changed in R5.1a.
  This option lets you choose old or new behavior. The option is
  under Configure -> Options -> Debugger.

  When exporting a chart or copying blocks, items only within
  OptoScript blocks are now included.

  Bug Fixes:
  ----------

  When entering debug mode, existing breakpoints in the control
  engine were not being displayed in ioControl.

  (KB1428) - When inspecting an action block while in Online mode,
  the AND/OR operators would incorrectly appear as an option within
  the window. These operators are only for a Condition block.

  (KB48089) - In the Edit PID Loop dialog, the range checking for
  forced output values was incorrect.

  (KB47922) - In commands, ioControl would allow the user to enter an
  integer literal that was out of range. A -13 overflow error would
  occur when the strategy was downloaded to a controller.

  Invalid numeric literals could be entered in the Add Instruction
  dialog.

  ioControl would crash if an ActiveX control was not loaded.
  The dialogs affected are View PID Loop and Inspect Table, both
  in the debugger.

  When stepping through OptoScript blocks with 'case' statements,
  the 'break' keyword had incorrect line information.

------------------------------
For Version R6.1c 
(July 28, 2005):
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  New Features:
  -------------

  Added support for the following modules:
    SNAP-AOA-23-i
    SNAP-AIMA2-i modules.
    SNAP-AILC module.

  Added the following commands:
    Set Analog Load Cell Fast Settle Level
    Set Analog Load Cell Filter Level

  Enhancements:
  -------------

  UIO now supports up to 32 PID loops.

------------------------------
For Version R6.1a 
(February 14, 2005):

  New Features:
  -------------

  Added support for new HDD modules.

  Bill of Materials tool.

  Added the following commands:
    Get HDD Module States
    Get HDD Module On-Latches
    Get HDD Module Off-Latches
    Get & Clear HDD Module On-Latches
    Get & Clear HDD Module Off-Latches

    Get All HDD Module States
    Get All HDD Module On-Latches
    Get All HDD Module Off-Latches
    Get & Clear All HDD Module On-Latches
    Get & Clear All HDD Module Off-Latches

    Clear HDD Module On-Latches
    Clear HDD Module Off-Latches

    Get HDD Module Counters
    Get & Clear HDD Module Counters
    Get & Clear HDD Module Counter

    Set HDD Module from MOMO Masks
    Turn On HDD Module Point
    Turn Off HDD Module Point

  Enhancements:
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  -------------

  Bug Fixes:
  ----------

  In the ioControl debugger, when changing the value of a string variable or
  string table element, strange behavior could happen if another application
  (such as ioDisplay) was also communicating with the control engine's
  host port.

  The following OptoScript for/next loop would execute once, when it should
  not have looped at all. This would result with x being 1 when it
  should be 0.

        x = 0;
        for n = 0 to -1 step 1
          x = x + 1;
        next

------------------------------
For Version R6.0b:
  Bug Fixes:
  ----------

  In the debugger, if an analog point's XVAL was out of range, it was not
  possible to change the IVAL. You would get an error that the XVAL was
  not valid. This bug was introduced in version 5.0.

  In the debugger, in binary view mode, it was not possible to change the
  bits of an integer 64 variable.

  When adding or editing analog temperature points, the dialog showed their
  units as being Celsius, even if the I/O unit was set Fahrenheit. This was
  a display problem and did not affect the compiler or debugger.

  When copying a block from a chart into a subroutine, it was possible
  to copy types that are not allowed in subroutines. This included pointer
  variables, pointer tables, and PID loops. This would causes various types
  of strange behavior, including items showing up at the top of the
  strategy tree and problems when running the strategy on a device.
  ioControl will now check for this when pasting blocks into a subroutine.
  I/O units, points and charts were already being checked.

  The following commands did not allow points which were on
  a Mixed 64 I/O unit:
    Calculate & Set Analog Gain
    Calculate & Set Analog Offset
    Get & Clear Analog Maximum Value
    Get & Clear Analog Minimum Value
    Get Analog Maximum Value
    Get Analog Minimum Value
    IVAL Set Analog Point
    Set Analog Filter Weight
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    Set Analog Gain
    Set Analog Offset
    Set Analog TPO Period

------------------------------
For Version R6.0a 
(October 1, 2004):

  New Features:
  -------------

  Added subroutines to allow greater flexibility in building flowcharts.

  Added the following commands:
    Set Analog Filter Weight
    Float Valid?
    Get Available File Space

  Enhancements:
  -------------

  I/O units may now share an IP address if their ports are different.

  Bug Fixes:
  ----------

  Digital points in slot #63 with the watchdog turned on no longer cause an
  overflow error when downloading the strategy.

  Using timers with mathematical and comparison commands now reliably returns
  accurate results.  Some mathematic and comparison results were sometimes
  inaccurate when used in Action and Condition blocks with commands such as
  Add, Subtract, Divide, Multiply, Maximum, Minimum, Equal?, Greater Than or
  Equal?, Greater?, Less?, Less Than or Equal?, Not Equal?.

  I/O unit watchdog timeout values are now sent to I/O units only when
  configured to do so.

  ioControl no longer negatively affects mouse behavior in other running
  applications, as it sometimes did previously.  The effect was noticed with a
  two-wheel mouse, but could have caused other problems, too.

  A PID loop with a setpoint type coming from another PID's output is now
  correctly compiled.

  ioControl no longer tends to lock up while inspecting PID loops with
  unplugged input points.  A new version of the iPlotLibrary.ocx plot control
  fixed the problem.

  The "Command Help" button in an OptoScript dialog box will now reliably
  bring up the Command Reference Help, even if the command is completely
  highlighted.
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  The I/O Unit Inspect dialog now correctly displays all bits from the last
  letter in the version. For instance, an Ethernet I/O unit with a R3.0q
  kernel was displayed as "R3.0a".

  The following commands now compile correctly when using D64-type brains as
  a parameter.
      Read Number from I/O Unit Memory Map
      Write Number to I/O Unit Memory Map
      Numeric Table Element Bit Test
      Get I/O Unit as Binary Value
      Bit Clear
      Bit Rotate
      Bit Set
      Bit Test
      Bit On?
      Bit Off?

  The IVAL Set Analog Point command now compiles correctly when an integer is
  used as the source value.

  Using the AddMessageToQueue command in an OptoScript block no longer causes
  a download error.

------------------------------
For Version R5.1b 
(February 11, 2004):

  Bug Fixes:
  ----------

    It was not possible to add PID loops to Ethernet I/O units created in
    pre-5.1 versions of ioControl. This version will both fix and prevent the
    problem.

    A bug fix in R5.1a regarding 'for' loops with a negative step was not
    correct.

    The command "Convert Number to Hex String" didn't work correctly for
    Integer 64s.

------------------------------
For Version R5.1a 
(December 1, 2003):

  New Features:
  -------------

    PID loops

    Added support for the SNAP-ENET-S64 product, known in ioControl
    as SNAP Mixed 64 Simple I/O.

    Added the following commands:
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      Copy Current Error to String
      Add Message to Queue
      Get Severity of Current Error

      Get PID Input
      Get PID Current Input
      Get PID Setpoint
      Get PID Current Setpoint
      Get PID Feed Forward
      Get PID Output
      Get PID Gain
      Get PID Tune Integral
      Get PID Tune Derivative
      Get PID Feed Forward Gain
      Get PID Max Output Change
      Get PID Min Output Change
      Get PID Input Low Range
      Get PID Input High Range
      Get PID Output Low Clamp
      Get PID Output High Clamp
      Get PID Scan Time
      Get PID Forced Output When Input Under Range
      Get PID Forced Output When Input Over Range
      Get PID Mode
      Get PID Configuration Flags
      Get PID Status Flags

      Set PID Input
      Set PID Setpoint
      Set PID Feed Forward
      Set PID Output
      Set PID Gain
      Set PID Tune Integral
      Set PID Tune Derivative
      Set PID Feed Forward Gain
      Set PID Max Output Change
      Set PID Min Output Change
      Set PID Input Low Range
      Set PID Input High Range
      Set PID Output Low Clamp
      Set PID Output High Clamp
      Set PID Scan Time
      Set PID Forced Output When Input Under Range
      Set PID Forced Output When Input Over Range
      Set PID Mode
      Set PID Configuration Flags

      Disable Communication to PID Loop
      Enable Communication to PID Loop
      PID Loop Communication Enabled?

      Set Simple 64 I/O Unit from MOMO Masks
      IVAL Set Simple 64 I/O Unit from MOMO Masks

  Enhancements:
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  -------------

    Info and warning messages have been added to the error queue.

    The Add Module dialog has been improved.

    Dialogs in the Configurator now know if a change has actually
    been made when the OK button is used to close the dialog. This
    should help prevent many cases of inadvertently making a change
    that would then require a download before entering Debug mode.

    In the debugger, the "Step Line" and "Step Block" buttons have
    been replaced with "Step In", "Step Over", and "Step Out"
    buttons.

    The "Command Help" button in the OptoScript dialog is now
    smarter.

    Keyboard and mouse standard shortcuts were added:
      When a block is selected, the F2 key brings up the Name Block
      dialog.

      When a flowchart window is selected, holding the CTRL key while
      scrolling the mouse wheel will change the zoom setting.

    While stepping through a chart, if the active step block is not
    visible, it will be scrolled into view.

    Added the ability to clamp analog output points.

    When archiving a strategy to a control engine and then uploading
    the archive back to a PC with ioTerm, you can now go directly
    into debug mode without downloading.

    Resolved several issues with idle session timeouts.

  Bug Fixes:
  ----------

    In a flowchart, making multiple object selections with the Shift
    key was not working.

    Some combo boxes in the Find and Replace dialogs were not wide
    enough to show all of their content.

    For SNAP-AOA-23 and SNAP-AOV-25 modules, the "Custom..." scaling
    button was incorrectly enabled in the Edit Analog Point dialog.

    Communication Handles were not being created when Action and/or
    Condition blocks were pasted between strategies.

    In watch windows, pointer variables were not displaying properly.

    When opening a chart window, it was possible that it would be
    placed outside of the viewable area.
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    String Tables with long initialization strings could cause
    download errors.

    String Tables using the "Initialize on strategy download" option
    were not being initialized correctly.

    In OptoScript blocks, some float literals were being truncated
    when compiled. For instance, 5.335004e-7 was being truncated to
    0.000001.

    In OptoScript blocks, 'for' loops with a negative step did not
    work properly. They did one less iteration than they should.

    Adding I/O points on-the-fly would not work if a type-mismatch
    occurred.

------------------------------
For Version R5.0a
(August 1, 2003):

  New Features:
  -------------

    Added support for the SNAP-UP1-M64 product, known in ioControl
    as SNAP Mixed 64 Ultimate I/O.

    Two new communication handle drivers: "file" and "ftp".

    Added the following command(s):
      Get Type From Name
      Get Value From Name

      Send Communication Handle Command
      Transfer N Characters

      Convert IP Address String to Integer 32
      Convert Integer 32 to IP Address String

      Erase Files in Permanent Storage
      Save Files To Permanent Storage
      Load Files From Permanent Storage

      Set Mixed 64 I/O Unit from MOMO Masks
      IVAL Set Mixed 64 I/O Unit from MOMO Masks

  Bug Fixes:
  ----------

    In some situations, unnecessary downloads were being required when
    changing to debug mode. To reproduce:
      1. Download a strategy 2. Go to Config mode  3. Change a chart
      (like adding an empty block)  4. Go to Debug mode. It will do a
      normal download 5. Go to Config mode  6. Close the strategy
      7. Open the strategy  8. Go to Debug mode. It will require a
      download, even though it shouldn't.
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------------------------------
For Version R1.0d
(April 4, 2003):

  Bug Fixes:
  ----------

    Duplicate variables could be created in the strategy database
    when removing a variable from two or more charts and then
    deleting the variable.

------------------------------
For Version R1.0c
(August 15, 2002):

  New Features:
  -------------

    Added the following command(s):
      Get End-Of-Message Terminator
      Set End-Of-Message Terminator
      Clear Communication Receive Buffer
      Compare Strings
      Move to Numeric Table Elements
      Move to String Table Elements

    Added the ability to make a "control engine download file". This
    makes it easy to download a compiled strategy for a specific
    control engine using ioTerm.

 Enhancements:
  -------------

    Object selection and interaction using the mouse is now much
    closer to Windows standards.

    In the debugger, controller busy errors will now be retried
    several times before posting a message.

    In the debugger, the error field in the status bar is now
    highlighted red and will display the Inspect Controller dialog
    when clicked.

    An "A_" is no longer prepended to the beginning of a name when
    naming an object. The name will be checked either when the focus
    has changed or the dialog is closed.

    When adding an I/O unit, Ultimate I/O is now the default, not
    Ethernet I/O.

    The time it takes to record a variable or I/O name change has been
    decreased in large strategies that have charts without OptoScript
    blocks.
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    The time it takes to initialize a table has been greatly improved.

  Bug Fixes:
  ----------

    Pointer variables using the "Initialize on strategy download" option
    were not being properly initialized.

    In strategies that have OptoScript blocks, the Find and Replace
    dialogs were occasionally having problems and showing the "Could
    not open OptoScriptTemp.txt for the OptoScript compiler" error
    message.

    OptoScript blocks with unterminated comment blocks (i.e. /* and */ )
    would cause the OptoScript lexical analyzer to enter an incorrect
    state, causing unexpected behavior.

    When moving an I/O point referenced in an OptoScript block to a
    different location, the reference count for the item would become
    incorrect.

    The debugger's string table inspect dialog was not properly
    displaying tables that were wider than 127 characters.

    Focusing issues in the "Add Instruction" dialog have been addressed.

    The Find and Replace dialogs were not finding instances of
    communication handles in OptoScript blocks.

    When using the Replace All button in the Replace dialog to replace
    items in OptoScript blocks, neither the old or new items would
    have their reference counts updated.

------------------------------
For Version R1.0b
(November 21, 2001):

  New Features:
  -------------

    Added an "Inspect Communication Variable" dialog for inspecting
    communication handles in the debugger.

    Added a "Command Help" button to the OptoScript editor dialog.

    Added a "Strategy Information" menu item for displaying the
    open strategy's file name and path.

    Added the following commands:
      Receive String Table
      Receive Pointer Table
      Transmit String Table
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      Transmit Pointer Table
      Get Pointer From Name

  Enhancements:
  -------------

    The "Inspect Control Engine" dialog has been improved. The
    "Persistent RAM" and "Revision Time" fields are new.

    The "Inspect Control Engine" dialog now uses a different method
    for determining the communications loop time.  It now displays
    the time taken for one single transaction, rather than several.

    The "Move Numeric Table to Numeric Table" command now checks
    for valid table lengths and indexes.

    Automatically saving a strategy to flash memory after making an
    online change has been enabled.

    The commands "Receive Numeric Table" and "Transmit Numeric Table"
    now support Integer 64 Tables.

Bug Fixes:
----------

٭ The "Move To" feature in the "Configure I/O Points" dialog was incorrectly 
allowing points to be moved to the wrong location.

٭ The "Select Continue Block Destination" dialog was not showing OptoScript 
blocks.

٭ Syntax errors in OptoScript code involving a table would not display the 
correct error line number.

٭ String assignments in OptoScript would not work correctly if the same item 
was on both sides of the assignment operator.

٭ It was possible to copy or import a chart with a name that already existed in 
the strategy database.

٭ Importing charts with I/O units in them could lead to multiple I/O units 
having the same address. An added I/O unit will now have an initial IP 
address of 0.0.0.0.

٭ When importing charts or copying block, I/O points that needed to be added 
were not being added in the proper location.

٭ When importing charts, integer 64 variables and tables were not being matched 
correctly.

٭ In the debugger, setting a string variable or table element to be empty would 
cause the control engine to lock up.

٭ Any OptoScript or Instruction dialogs opened because of line stepping were 
not being automatically closed when leaving the debugger.
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٭ The command "Get Nth Character" was returning a -42 error for a string with 
non-printable characters even though the index was valid.

٭ The command "Convert IEEE Hex String to Number" was not always returning the 
correct value. For example, the manual uses the example of 418E666 converting 
to 17.8, but the command was returning 18 instead.

=====================================================================

Uninstallation of this Product:
------------------------------

A utility is provided to uninstall this product. The utility will
remove all registry entries and files previously installed.
Exceptions to this are:

- Previously configured control engines are not removed from the registry.
- The installation directory tree is not removed if any user-created
  files exist in it.
- The program folder or group is not removed if any icons have been
  added by the user.

ioDisplay
ioDisplay Professional R7.1j
ioDisplay Basic R7.1j
December 18, 2006

Bug Fixes – Configurator

٭ (KB55256) A problem inadvertantly introduced in ioDisplay 7.1i has been 
corrected where functions that had to write to the hard drive would fail. 
This included historic logs, SuperTrends, alarms, etc.

=============================================================
ioDisplay Professional R7.1i
ioDisplay Basic R7.1i
December 11, 2006

Bug Fixes – Configurator

٭ (KB55175) Fixed a bug where, when configuring an XY-Plot, the "Show Legends 
In Runtime" checkbox would always be selected, causing the legends to always 
appear in Runtime.

٭ (KB55016) A problem has been corrected where if you try to set the priority 
of the Lo alarm point it would not stick when you exited and returned.

Bug Fixes –   Runtime  
٭ (KB55177) Fixed a bug where alarms, if configured with a Conditional tag 

would not always show the correct state. They wouldn't always appear if 
alarmed, and would still show if the condition evaluated to false. 

٭ (KB55178) Fixed a bug introduced in R7.1g where if an Alarmpoint value was 
set by a tag, the alarmpoint never went into alarm.

٭ (KB54490) A problem has been corrected where if you created a short cut on 
your PC to run ioDisplay Runtime with a specific project, and the project's 
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Alarming Setup was configured to locate the sound file in the project 
directory, the sound would not activate when the alarm was triggered.  

Enhancement - Runtime

٭ (CR55179) Added enhancement where, if alarmpoints are in a NORMAL state at 
Runtime startup, they are NOT added to the History alarm. The NORMAL state 
now only appears in the History Alarm once the Alarmpoint returns from an 
alarmed state.

=============================================================
ioDisplay Professional R7.1h
ioDisplay Basic R7.1h
November 22, 2006

Internal release only.

=============================================================
ioDisplay Professional R7.1g
ioDisplay Basic R7.1g
October 23, 2006

Bug Fixes – Configurator

٭ (KB51157) A problem has been fixed where ioDisplay might become unresponsive 
after importing a corrupt "Tocpidfp.smb" file from the \Support\3dSymbol 
folder.

٭ (KB51758) A problem has been fixed where the Offset feature in the Send Value 
dynamic attribute did not work as expected. The ‘offset’ value should be 
added to the tag’s current value, but instead the current value plus the 
offset was added each time.

٭ (KB52368) A problem has been fixed where ioDisplay Configurator crashed when 
a SuperTrend was configured to collect one point of data once a day, and then 
configured to display seven days of data.

Bug Fixes –   Runtime  

٭ (KB52200) A problem has been fixed where an ioDisplay project with a trend 
that has not been configured caused ioDisplay Runtime to crash when the 
project was run.

=============================================================
ioDisplay Professional R7.1f
ioDisplay Basic R7.1f
August 15, 2006

ioDisplay 7.1f was an internal release only.

=============================================================
ioDisplay Professional R7.1e
ioDisplay Basic R7.1e
May 18, 2006
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Bug Fixes - Runtime

٭ (KB51612) A problem has been fixed where if the Alarming Setup was configured 
as "Play sound continuously while any alarm is active", and a .wav file 
longer than 1-2 seconds was chosen, the sound would not play until the alarm 
was acknowledged, and then play only once.

=============================================================
ioDisplay Professional R7.1d
ioDisplay Basic R7.1d
May 4, 2006

Bug Fixes – Configurator

٭ (KB51184) A problem has been corrected where copying a metafile within 
ioDisplay could cause Configurator to crash or the metafile to disappear when 
the metafile is pasted or the undo feature is used.

٭ (KB51157) Opto 22 is currently looking into a problem where a bad symbol file 
in the Symbols subfolder causes Configurator to crash. The problem has been 
solved temporarily by removing the symbol, which will be returned when a 
permanent solution is found.

[PRO]
٭ A problem has been corrected where the I/O Unit Tags tab of Configure-

>Runtime wasn't adding D64 I/O units.
٭ A problem has been corrected where the I/O Unit Tags tab of Configure-

>Runtime was adding pointer types.

Enhancements - Configurator

[PRO]
٭ A new Uncheck All / Check All button has been added to the I/O Unit Tags tab 

of Configure->Runtime.
٭ The I/O Unit Tags tab of Configure->Runtime has been enlarged.

Bug Fixes - Runtime

٭ A problem has been corrected where the Alarm Log file was not including the 
year.

Enhancements - Runtime
٭ Upload Recipe Results file no longer has square brackets around indexes.
٭ Upload Recipe Results file no longer has trailing space after last entry for 

a table.

=============================================================
ioDisplay Professional R7.1c
ioDisplay Basic R7.1c
April 20, 2006

Bug Fixes – Configurator

٭ The Preserve OptoDisplay compatibility checkbox in the Trend dialog has been 
removed. It was nonfunctional. To make trends display as they did in 
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OptoDisplay, use Trend Backward Compatibility in the Runtime Setup dialog 
(Configure->Runtime).

٭ Corrected a problem where metafiles were disappearing for two reasons:
1) Once the Undo buffer limit was reached, the oldest redo item was deleted. 
If this redo item contained a reference to a metafile, the metafile was 
deleted;
2) (KB51150) Dragging and dropping a metafile from SymbolFactory or another 
application, and then modifying the attributes of the metafile was causing it 
to disappear.

New Features   – Configurator  

٭ Configuring automatic synching of control engines to PC time has been added 
in the Configure->Runtime dialog under the Control Engines tab.

[PRO]
٭ There is now an option in the Execute Menu Item Operator Driven Dynamic 

Attribute to display the Configuation Status dialog in Runtime.

Bug Fixes - Runtime 

٭ Corrected a problem where the Sync control engine to PC time command would 
sometimes fail.

٭ Corrected a problem where on startup, occasionally there were erroneous 
messages stating that "AddItems failed"  but no item names were shown.

٭ (KB51005)Corrected a problem where if AlarmPoints were configured to use a 
Discrete Conditional tag, the alarmpoint was ignoring the condition.

٭ Corrected a problem where if AlarmPoints were configured to use conditional 
tags, and the alarmpoint was triggered, and then the condition went false, 
the alarmpoint was not removed from the alarm graphics.

٭ Corrected a problem where if a Text Color attribute was set for a graphic, 
and then the text was changed (either by the strategy or a Send String 
command), the text was displaying as black, rather that retaining the 
previous color.

٭ Corrected a problem where the Alarm Graphics were not displaying the year 
when alarmpoints were added.

=============================================================
ioDisplay Professional R7.1b
ioDisplay Basic R7.1b
April 7, 2006

Bug Fixes - Configurator

٭ (KB50840) Corrected a problem where if pasting a graphic into a window 
failed, Configurator was not properly releasing the clipboard. Configurator 
had to be closed to release the clipboard.

٭ Corrected a problem where the Tools->Regenerate IO Scanner Tags command was 
not generating tags for the Upload Recipe Destination File tag if "Mistic 
String" was selected.

٭ Fixed a problem where clicking Cancel while the Tools->Regenerate IO Scanner 
Tags command was running would cause Configurator to hang.

New Features   - Configurator  
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٭ Multiple alarmpoints may now be deleted at one time.
٭ The Configure->Runtime dialog now has two new options:

-"Format Value Data With Commas" now allows the user to choose whether commas 
are displayed for value data. This option is selected by default.
-"Trend Backward Compatibility" - This option displays Trend (not SuperTrend) 
data the same as OptoDisplay. OptoDisplay graphed Trend data as if the "Y-
Axis" Label Position had been set to "None", even if labels were present. 
Selecting this option displays ioDisplay Trends the same way.  This option is 
disabled by default.

Bug Fixes - Runtime 

٭ A problem has been corrected where on rare occasions, if a project contained 
large numbers of alarmpoints, not all of the alarmpoints were being added to 
the OPC Server.

[PRO]

٭ A problem has been fixed where the Window Menu would occasionally still 
display closed windows as being open, and vice versa.

٭ A problem has been corrected where the View->Configuration Status dialog was 
not showing all IO Units.

٭ A problem has been corrected where some Windows tags were not being added to 
the scanner when they belonged to the same group as other tags in the same 
window.

=============================================================
ioDisplay Professional R7.1a
ioDisplay Basic R7.1a
March 8, 2006

Information in this README file applies to both versions unless otherwise
indicated with [BAS] or [PRO].

New Feature – Configurator and Runtime

Added support for SNAP-PAC-R1 and SNAP-PAC-R2.
 
Bug Fix - Configurator
٭ A problem has been remedied where High Density Digital I/O Scanner Tags were 

being generated incorrectly.
[PRO]
٭ When selecting a element of a string scratchpad table, Configurator now 

correctly limits the maximum element to 63. Previous versions allowed 
selecting elements up to 10,239.

=============================================================
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ioDisplay Professional R7.0e
ioDisplay Basic R7.0d
February 2, 2006

Bug Fixes – Runtime 
------------------------

[PRO]
٭ (KB49885) A problem has been corrected where enabling or disabling a 

SuperTrend pen in Runtime was causing ioDisplay to crash.
٭ A problem has been corrected where ioDisplay Runtime would either fail to 

connect to the backup server, or randomly crash. This would occur if a 
redundant OPC Server had been configured, and the primary OPCServer was not 
available at Runtime start-up.

[BAS]
(KB49872) Trends would stop graphing data if all monitored tag values remained 
unchanged for a period of time.

Enhancements – Runtime
------------------------

٭ Trend scaling has now been modified as follows: 
If the Y-Axis "Label Position" is set to "None", all pens are displayed and 
are scaled proportionally to the height of the Trend graphic; if the "Label 
Position" is set to any other setting, only pen data falling in the Y-Axis 
"Label Range" of values is displayed.

[PRO]
٭ Failure to remove groups or items from the OPCServer now only displays error 

messages in the Event Log if ioDisplay is able to communicate with the 
server.

=============================================================
ioDisplay Professional R7.0d
ioDisplay Basic R7.0c
January 26, 2006

Additions - Configurator
------------------------

[PRO]
The "Sync All Control Engines to PC Time" is now available under the 
"Execute Menu Item" Operator Driven Dynamic Attribute. Note: This command 
syncs all controllers / control engines to the time of the PC that is 
running the OPCServer, not the PC that is running ioDisplay Runtime (if 
different). Also, this command is not available in ioDsrX.pro.exe.

Additions - Runtime
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------------------------

A menu item under the "View" menu allows syncing all control engines to 
the PC time; Note: this command syncs all controllers / control engines to 
the time of the PC that is running the OPCServer, not the PC that is 
running ioDisplay Runtime (if different). Also, this command is not 
available in ioDsrX.pro.exe.

Bug Fixes - Configurator
------------------------

A problem has been fixed where tags in table controls were not getting 
properly updated when executing the "Tools > Regenerate IO Scanner Tags" 
command.

Bug Fixes - Runtime
------------------------

[PRO]
٭ (KB49757) A problem has been fixed where the time display in Alarms was 

displaying only minutes and seconds, and omitting the hour.

[BAS]
٭ The "Sync All Control Engines to PC Time" Operator Driven Dynamic Attribute 

now works correctly when multiple control engines are configured.

=============================================================
ioDisplay Professional R7.0c
ioDisplay Basic R7.0b
January 19, 2006

Enhancement – Configurator
------------------------

٭ The AutoCorrect Tags feature now uses substantially less memory and GDI 
resources.

Bug Fixes - Configurator
------------------------
٭ (B50630) The AutoCorrect Tags feature no longer repeatedly misses some tags.

[BAS]
٭ A problem fixed where displaying negative numbers would sometimes add an 

extra comma before the number.

Bug Fix - Runtime
------------------

٭ (KB50631) A problem has been resolved where periodically a "TValue::Get" 
error message would be displayed indicating a NULL value type had been 
requested. This would occur when both Send Discrete and Send Value dynamic 
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attributes were configured for a graphic, and the Runtime Operator Action 
Logging feature was enabled. 

=============================================================
ioDisplay Professional R7.0b
ioDisplay Basic R7.0a
------------------------------
January 12, 2006

Enhancements
------------------
* Metafile drawing code has been enhanced to minimize the appearance of random
 lines appearing on some metafiles.

[PRO]
٭ The application executables have been renamed to:

ioDisC.pro.exe
ioDisR.pro.exe
ioDsrX.pro.exe

* Performing a Operator Driven Discrete Set now mimics previous versions of
 ioDisplay in setting an integer value where no bit index was specified to a
 +1 instead of a -1.

[BAS]
٭ Application executables have been renamed to:

ioDisC.basic.exe
ioDisR.basic.exe
ioDsrX.basic.exe

Bug Fix
------------------
[BAS]
٭ A problem has been resolved where the message, "Unable to Load PID Objects" 

would appear when configuring tags in certain projects in ioDisplay 
Configurator Basic.

=============================================================
ioDisplay Professional (R7.0a)
ioDisplay Basic (R6.2a)
------------------------------
December 8, 2005

ioDisplay software is now available in two versions: ioDisplay
Basic and ioDisplay Professional.  Information in this README file
applies to both versions unless otherwise indicated with [BAS] or
[PRO].

For information about the differences between Basic and Professional
versions of ioProject software applications, see the ioProject
Professional 7.0 Release Notes (Opto 22 form 1599).  This document
is included with all ioProject software and can also be downloaded
from the Opto 22 website at www.opto22.com.

README: ioProject 7 25



[PRO] ioDisplay Professional adds several new features:

* Support for Ethernet link redundancy using the dual
  Ethernet network interfaces on SNAP PAC controllers.
  You can designate primary and secondary control engines;
  if the primary is not available, ioDisplay Pro will switch
  to the secondary control engine. For maintenance or testing,
  you can also manually switch control engines.

* Conversion of OptoDisplay projects to ioDisplay projects.

* Connection to FactoryFloor controllers running OptoControl
  strategies.  (SNAP-LCM4 with M4SENET-100 adapter card only.)

* Ability to read and write I/O unit data through the control
  engine as well as directly from the I/O unit itself. This
  ability means you can set up segmented networks using a SNAP
  PAC controller, with one Ethernet interface used for the
  control network and one to communicate with hosts.  (ioDisplay
  Basic, in contrast, must talk directly to I/O units.)

* Primary and secondary scanners. As with control engines,
  if the primary is not available, ioDisplay Pro will switch
  to the secondary. You can also manually switch scanners.

* Real-time overview of control engine and I/O unit status.

* Access to Scratch Pad bits, integers, floats and strings;
  pointer variables; PIDs; event/reactions; and limited support
  for Integer 64 variables.

* The ability to replace controllers, item names, table and
  bit indices for windows, alarm points, historic logs, sounds,
  triggers, and so on, for the entire project.

[BAS] Enhancements
------------------
* ioDisplay Basic is very similar to the previous ioDisplay
  version 6.1, with the addition of support for new SNAP PAC
  controllers.

Bug Fixes
---------
The following issues have been resolved:

* Digital input and output points are visible and can now
  be added to a Historic Data Log.

* ioDisplay will not unexpectedly terminate for some Runtime
  windows containing Windows metafile graphics (.wmf or .emf).

* Some bitmaps were focus-frame and beep enabled inadvertently;
  this problem has been fixed.

* RAM used for a SuperTrend is now correctly shown in kilobytes (KB)
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  rather than megabytes (MB).

* Negative values in ioDisplay windows are correctly shown.
  (Previously, some had an extra comma.)

* Lo alarms associated with a tag under Setup By Current Value
  are triggered correctly.

* Historic logging works correctly. (The problem occurred when
  a new control engine was used and the log file name was created
  from a String Name.)

* An erratic good/bad data state associated with a 64-bit integer
  tag or a 64-bit integer table element has been fixed.

=============================================================
ioDisplay Software R6.1a
May 31, 2005

Enhancements
------------
 * Support for SNAP high-density digital input and output modules:

     * SNAP-IDC-32
     * SNAP-ODC-32-SRC
     * SNAP-ODC-32-SNK

   Each of these modules provides 32 digital input (SNAP-IDC-32) or 32 digital
   output (SNAP-ODC-32-SRC and SNAP-ODC-32-SNK) points, for a total of up to
   512 digital points on a 16-module mounting rack.  Features differ from
   those in standard digital modules; for details, see Opto 22 form #1556,
   the SNAP High-Density Digital Module Data Sheet.

 * There is a new operator-driven “Read and Clear” dynamic attribute for reading
 a tag value and then clearing (reset) it. The following values can be read and
 cleared:

     * Counts (returns an integer value and then clears counts)
     * On time total
     * Off time total
     * Latch (ON)
     * Latch (OFF)
     * On pulse measure
     * Off pulse measure
     * Period

 * In the operator-driven “Send Value” dynamic attribute, values can now be
 formatted as hexadecimal numbers.

 * A SuperTrend object’s y-axis can now be scaled logarithmically.

 * An individual draw window in an ioDisplay project can now be exported, saved
 as a file, and then imported into another ioDisplay project.  The exported
 window file contains all the objects and tags that were in the original window.
 Exporting and importing draw windows is a convenient way to reuse the same
 window in different ioDisplay projects.
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 * Each drawing tool in the toolbox now has a shortcut key associated with it to
 make selecting and switching between tools easier and faster.  To choose a 
tool, just press the corresponding key on the keyboard.  Hold the cursor over a 
tool to find out which shortcut key is associated with it.

 * Added “Regenerate IO Scanner Tags” item to Tools menu.

 * Space and NULL characters are now removed from an Upload Recipe results file.

 * Vertical and horizontal spacing of objects has been improved.

 * The “Disk Full” error message is now more specific.  This error is now also
 reported in the Event Log.

Bug Fixes
---------
The following problems were addressed in this release of ioDisplay:

٭ ioDisplay Configurator would crash if the user security group(s) and/or 
user(s) specified in the project were not present on the local domain.

٭ Alarmpoints were not always correctly added to the Runtime scanner.
٭ If an alarm sound was removed from an alarm and “Play until Acknowledged” was 

selected, the sound removed still played for that alarm.
٭ The “Alarmpoint Controller Status” tag is now sent to the Runtime scanner.
٭ For a PID loop, the IP address and port can now be configured correctly.
٭ Incorrect PID Item Names were being generated occasionally
٭ For a PID loop, the "Out Hi Clamp" and "Out Lo Clamp" values were being sent 

to "Input Under Range" and "Input Over Range".
٭ The auto/manual flag for a PID loop was not toggleable or settable.
٭ The "opening window" message is now only displayed if Runtime is the active 

application.
٭ When logging value changes, the operator action log file would incorrectly 

indicate that the "previous value" was always zero.
٭ In Configurator, the "Save Metafile As" command did not correctly save 

metafiles to disk.
٭ String writes with space or NULL strings were not working.
٭ SymbolFactory location is now predefined to reduce possible installation 

problems.
٭ Autocorrect tags now checks for available display resources on the computer.
٭ Historic log triggers were not added to the correct scanner group.
٭ Historic logs did not perform an initial scan when a trigger event occurred. 

Subsequent scans functioned correctly.
٭ Selecting and moving a large number of metafiles (usually 50 or more) on 

screen sometimes caused display problems.

===============================================================================
ioDisplay Software R6.0a
October 1, 2004
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Enhancements
------------
 * An expanded testing regimen has improved both the reliability and performance
 of the software over the previous version, ioDisplay 5.1.  In particular,
 ioDisplay Runtime now opens and starts large ioDisplay projects much faster
 than before.

 * Recipes now support up to 2048 entries per table.

 * Numeric table objects now support up to 500 elements per table.

 * When configuring a SuperTrend, the estimated amount of memory the SuperTrend
 will use is now shown.

 * When using an ioDisplay project in Runtime, individual SuperTrend pens can
 now be either hidden or disabled.

Bug Fixes - Configurator
------------------------

 * Fixed a problem in the Configure Tag dialog box where, if the backspace key
 was pressed when the cursor was in the Element field, the Start Index and
 Number of Elements fields would become active.  This would allow table ranges
 to be entered where they are not allowed.

 * Corrected an error that occurred where a duplicate control engine ID was
 sometimes used when a new control engine was added to an ioDisplay project.

 * Fixed a bug where trigger names sometimes did not appear in dialog boxes.

 * Fixed a problem in the Configure Dynamic Attributes dialog box where, when
 using the Tab key to move between the location fields, objects would move
 around on the screen.

 * Corrected a problem where AutoCorrect tags did not include cleared tags that
 were imported from a project created in ioDisplay 1.0.

 * Fixed a bug where column widths for numeric table controls were not saved
 correctly.

Bug Fixes - Runtime
-------------------

 * Corrected the following problems in using recipes:
   - Float tables in a recipe download didn't work.
   - Recipe downloads and uploads would fail if ioDisplay wasn't monitoring any
   tags for the control engine specified in the recipe file.
   - When uploading and downloading recipes, a control engine string couldn't be
   used for the name of the destination file.
   - Notifications were not working after uploading or downloading a recipe.
   - Recipes weren't working if comment lines were embedded throughout the
   file.  In the upload results file, any comment lines were written at the
   top of the file before the actual data instead of in their correct
   locations.
   - An uploaded file could not be subsequently downloaded if brackets [] were

README: ioProject 7 29



   used around indices.
   - A blank line at the end of a file could cause Runtime to freeze.

 * Fixed the Silence/Unsilence alarm feature to operate correctly.

 * Corrected a problem where alarm sounds did not work correctly when combined
 with the Silence/Unsilence alarm feature.

 * Fixed the Offset feature to operate correctly.

 * Fixed the alarm point notifications to operate correctly.

 * Corrected a problem where historic logging did not work correctly when
 choosing the option From Strategy.

 * Fixed a bug where historic logs would sometimes display only commas for data,
 and display data at twice the refresh time or faster.

 * Fixed a problem when triggering an external application that used an appended
 string in the command line (for example, "C:/notepad.exe myfile.txt").

 * Corrected a problem where a backup controller would sometimes not operate.

 * Corrected a problem where the Toggle Discrete dynamic attribute would not
 work correctly when the object also had other dynamic attributes configured.

 * Fixed a problem where notifications were not working correctly for the
 Application Manager and Historic Logs.

 * Fixed a bug where SuperTrend historic logs started with the date 1601.

 * Fixed a bug where XY plots did not correctly display graphed data.

 * Corrected a problem with color text in a graphic where, if the text was
 changed but the Color dynamic attribute for the text was not changed, the new
 text would display in default Configurator black.

Known Issue -- Runtime
----------------------
Some customers set up ioDisplay Runtime to run automatically on a technician’s
PC with no other applications available.  In some cases, Windows operating
services that must run on the PC before ioDisplay Runtime opens may take too
long to launch.  If this happens, a dialog box will appear stating that a
necessary service is unavailable, and ioDisplay will not open.  If this
situation occurs, you need to add a delay to the ioDisplay launch.

Here’s how:
 1. Right-click on the ioDisplay Runtime icon in the Startup menu or folder, and
 choose Properties from the pop-up menu.
 2. In the Properties dialog box, add a delay in seconds at the end of the
 Target field (outside the quotation mark), in the format <space><delay value>.
 For example, to add a 20-second delay, you would type a space and then 20 as
 shown below:
                    "C:\Program Files\. . .\ioDispR.exe" 20

 3. Check how Runtime launches to make sure the delay is the right length, and
 adjust the delay value if necessary.
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===============================================================================
ioDisplay Software R5.1d
June 23, 2004

********** IMPORTANT ************ IMPORTANT *********** IMPORTANT ***********

ioDisplay R5.1d is distributed as a software patch, not as a standalone
installation program.  To use this patch, ioDisplay 5.1b must already be
installed on your computer.  See the instructions below for more information.

********** IMPORTANT ************ IMPORTANT *********** IMPORTANT ***********

Installing ioDisplay R5.1d if ioDisplay R5.1b Is Already Installed
------------------------------------------------------------------
Do the following:

 1) Exit ioDisplay Configurator and ioDisplay Runtime applications if they are
 currently running.

 2) Download the file ioDisplay_patch_R51d.zip from the Opto 22 Web site at the
 following link:

  http://www.opto22.com/support/softwareDrillDown/softwaredrilldown.aspx?Softwar
  eID=84

 3) Uncompress the ZIP archive using WinZip or a similar program.  The three
 .EXE files in this archive will replace three older files (R5.1b) with the same
 filenames.

 4) Now find the ioDisplay directory on your computer.  By default, ioDisplay is
 installed in the following location:

 c:\Program Files\Opto22\ioProject Software\ioDisplay

 5) Drag or copy the three files you uncompressed into the ioDisplay directory.
 When a prompt asks if you want to replace existing files, click Yes.

ioDisplay R5.1d installation is complete.

Installing ioDisplay R5.1d if ioDisplay R5.1b Is Not Installed
--------------------------------------------------------------
Do the following:

 1) Exit ioDisplay Configurator and ioDisplay Runtime applications if they are
 currently running.

 2) Install ioDisplay R5.1b on your computer.  If necessary, download the
 installer from the Opto 22 Web site at the following location:

  http://www.opto22.com/support/softwareDrillDown/softwaredrilldown.aspx?Softwar
  eID=4

 NOTE: You must purchase and register ioDisplay software if you have not already
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 done so.  Once registered, you can request a password from the Opto 22 Product
 Support group at support@opto22.com.

 3) Download the file ioDisplay_patch_R51d.zip from the Opto 22 Web site at the
 following link:

  http://www.opto22.com/support/softwareDrillDown/softwaredrilldown.aspx?Softwar
  eID=84

 4) Uncompress the ZIP archive using WinZip or a similar program.  The three
 .EXE files in this archive will replace three older files (R5.1b) with the same
 filenames.

 5) Now find the ioDisplay directory on your computer.  By default, ioDisplay is
 installed in the following location:

 c:\Program Files\Opto22\ioProject Software\ioDisplay

 6) Drag or copy the three files you uncompressed into the ioDisplay directory.
 When a prompt asks if you want to replace existing files, click Yes.

ioDisplay R5.1d installation is complete.

Bug Fixes -- Configurator
-------------------------
 * Corrected a "duplicate control engine ID" error that occurred when a control
 engine was added to an ioDisplay project.

 * Corrected a problem where tags that had been cleared weren't included when
 using AutoCorrect Tags on a project imported from ioDisplay R1.0.

 * Fixed a bug that caused trigger names to sometimes be displayed incorrectly
 in dialog boxes.

 * Corrected a problem in the Tag Configuration dialog box where pressing the
 Backspace key when the cursor was in an element field would make the Start
 Index and Number of Elements fields active.  This allowed table ranges to be
 configured, even if the tag being configured was not a table.

 * Fixed a bug in the Configure Dynamic Attributes dialog box that occurred when
 using the Tab key to move between controls.

Bug Fixes -- Runtime
--------------------
 * Multiple fixes to recipe handling:

   - Corrected a problem where recipe float tables were not downloaded correctly
   to the control engine running the ioControl strategy.

   - Fixed a bug where recipe downloads and uploads would fail if ioDisplay was
   not currently monitoring tags for the control engine specified in the recipe
   file.

   - Corrected a problem where uploading recipes with didn't work correctly if
   the option Filename from String Name was selected.
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   - Fixed a problem where notifications didn't work after uploading or
   downloading a recipe.

   - Increased the number of table entries that can be used in a recipe to 2048
   per table.

   - Corrected a problem where an uploaded recipe file could not be subsequently
   downloaded if brackets [ ] were used around table indices.

   - Fixed a problem where recipe files wouldn't work if comment lines were used
   throughout the file.

 * Corrected a problem where historic logging didn't work correctly if the
 option Filename from String Name was selected.

 * Fixed a problem where alarm point notifications did not work correctly with
 Application Manager and Historic Logs.

 * Corrected an error with toggling discrete tags that occurred when the tag was
 configured with another dynamic attribute.

 * Fixed a problem where the Offset feature didn't work on the Send Value
 dynamic attribute.

 * Corrected an error where a window state could not be configured by appending
 a string in a command line.

 * Fixed a bug where historic logs would sometimes display only commas for data,
 and sometimes display data at twice the refresh rate or faster.

 * Corrected a problem so historic SuperTrends no longer start with the "1601"
 date.

 * Corrected a problem where alarm sounds didn't work when used in conjunction
 with the Silence/Unsilence Alarm feature.

======================================================================
ioDisplay Software R5.1c
April 27, 2004

ioDisplay software R5.1c was made available briefly as a beta version to a small
number of testers, but this version was never formally released.

======================================================================
ioDisplay Software R5.1b
February 27, 2004

Enhancements
------------
 * In ioDisplay Runtime, multiple "not connected" and similar error messages
 appear when an ioDisplay project starts.  You can now choose whether to have
 these initial messages displayed.  To hide or show these error messages, in
 ioDisplay Configurator select Configure-->Scanner Location and then select or
 deselect the "Enable Bad Quality/Not Connected Errors" checkbox.

 * In the Scanner Location dialog box, the location "This computer" is now
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 selected by default.

Bug Fixes
---------
 * On digital points configured as counters, counters are now displayed
 correctly.

 * Correct Windows Help files for this version of ioDisplay are now installed.

 * Corrected error when a Historic Log is configured to get the filename from
 the controller. The Historic Log would not be created and a scan error
 (undefined) would be displayed.

 * Fixed problems in the View->Control Engines dialog box. Previously it still
 showed re-enable times. Also, if a control engine was not connected, it still
 said "Attached" even if no physical control engine existed.

 * If a control engine was not initially attachable, graphics for that control
 engine were not correctly displaying the "Detached on Error" color.

 * A trigger is no longer required to start or stop historic logs. Before, if a
 historic log was configured with no triggers, nothing would get logged.

 * Strings can now be written to string tables.

 * Recipes containing chart commands now work correctly.

 * Corrected problem when a window had the "Always in memory" box checked in
 Configurator, and then was closed in Runtime. Previously the data was still
 being scanned; now the group is disabled on the server so that no scanning
 takes place until the window is re-opened.

 * Fixed an error when trying to import an invalid metafile.

 * Graphic color changes for Last Known Value or Comm Error now occur as the
 graphic objects are being scanned instead of occurring all at once.

 * When multiple control engines must be monitored, selecting the Control Engine
 Status input dynamic attribute now shows the control engine that has the most
 critical status.  A control engine's status, however, can only be monitored if
 the control engine is already referenced elsewhere in the ioDisplay project,
 and the referenced item is in an active ioDisplay window.

======================================================================
ioDisplay Software R1.0b
February 1, 2002

Enhancements
------------
 * The ioDsrX version of Runtime now has the View->Controllers menu option
 available.

Bug fixes:
----------
 * Selecting integer and float table ranges when configuring tags
   is only allowed if configuring an XY Plot or Historic Data
   Log points.

README: ioProject 7 34



 * The option "Play sound continuously" now works correctly when
   using alarm points that are not inserted into an alarm graphic.

 * Deadbands for floats now work when configuring "Text In From
   Controller" Dynamic Attributes.

 * The "Switch Control Engines" menu option now appears correctly in
   Runtime.

 * Sending Discrete values to bits 0 through 31 of Integer64 types
   now works correctly in Runtime.

 * Metafiles are now properly pasted after being copied.

 * Repeatedly sending discrete values no longer locks the controller.

=====================================================================
Initial Release
ioDisplay Software R1.0a
October 15, 2001

Known Issues
------------
 * When running ioDisplay Configurator under the Windows 2000 operating system,
 the font used to format text in a text box may change as you edit or change the
 text box.  This problem does not occur when the ioDisplay project is run in
 ioDisplay Runtime.

OptoOPCServer
What's New in Version R7.1a?
April 7, 2006

Bug Fixes:
----------

٭ A memory leak was fixed that could occur when large numbers of string 
variables were continually added and removed from the server.

٭ (KB50037) A problem has been corrected where communications between 
OptoOPCServer and a device could sometimes fail resulting in a partial crash 
of OptoOPCServer. Communication to other devices would still be active, but 
the only way to recover was to restart the server.

٭ A problem has been corrected where occasional "out of service" errors could 
occur while rapidly adding and removing groups.

===============================================================================
What's New in Version R7.0c?
February 2, 2006

Bug Fix:
----------

(KB49807) A problem has been corrected where the server would crash when 
attempting to scan a string or string table strategy variable that no longer 
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exists. This might happen when the controller lost power and the strategy was 
not saved to flash.

===============================================================================
What's New in Version R7.0b?
January 26, 2006

Bug Fixes:
----------

٭ (KB49750) A problem has been fixed where client programs using 
OptoOPCAuto.dll could cause the server to fail if an item was added as 
inactive and later activated.

٭ (KB49750) A problem has been resolved where client programs using 
OptoOPCAuto.dll would not be able to modify the update rate for a group. 
Attempts to do so would set the update rate to 20ms. 

===============================================================================
What's New in Version R7.0a?
December 19, 2005

OptoOPCServer software is now available as part of the ioProject Professional
software suite.  You can also purchase OptoOPCServer separately.  See the
ioProject 7.0 Release Notes (Opto 22 form 1599) for more information.  This
document is included with all ioProject software, and can also be downloaded
from the Opto 22 website at www.opto22.com.

Enhancements:
-------------

1. Added support for redundant Ethernet links using the SNAP PAC controllers’
two Ethernet interfaces.  OptoOPCServer offers the ability to designate primary
and secondary controllers.  If the primary controller is not available,
OptoOPCServer will use the secondary controller.

2. Can obtain I/O data through a SNAP PAC controller rather than having to
talk directly with the I/O unit.

3. Since OptoOPCServer does not require an Ethernet connection to I/O units,
a segmented control network can be created using the SNAP PAC’s two network
interfaces.

4. Support has been added for FactoryFloor controllers running OptoControl
strategies, so that OPC clients can now work with data on these legacy control
systems.

Known Issues:
-------------

 * When an ioDisplay project is configured to use redundant OptoOPCServers,
ioDisplay or OptoOPCServer may stop operating or otherwise become unavailable.
Contact Opto 22 Product Support for current information on this problem.

===============================================================================
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What's New in Version R6.1a?
May 25, 2005

Enhancements:
-------------

1. Added support for High Density Digital modules.

Bug Fixes:
----------

1. The Browser Configurator will again allow editing of array type Item IDs.

===============================================================================
What's New in Version R6.0a?
October 1, 2004

Enhancements:
-------------

1. Digital point states and analog point engineering units can now be read from 
Ethernet-based controllers that are running OptoControl strategies.

2. Added ability select all items in the log by pressing Ctrl-A.

3. Added the number of items to the Group Information Tool Tip that is
displayed when hovering over a group in the tree view.

Bug Fixes:
----------

1. Sync Write now converts from types other than the canonical type.

2. Items added to an inactive group are not scanned until the group becomes
active.

3. When using IDataObject for subscription callbacks, float values now update
correctly.

4. Transferring a very large browser database from the Browser Configurator to
the server no longer fails.

5. The Browser Configurator is now able to open OTG files whose first point is
an analog output.

6. Sync Write no longer has difficulty with empty BSTRs being represented by a
NULL pointer.

7. Response times are not affected if groups are continually added and removed.

===============================================================================
What's New in Version R5.1b?
February 26, 2004

Bug Fixes:
----------
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1. Reading very large data requests from UIO controllers would sometimes cause
some elements of the data to change value for one scan cycle.

===============================================================================
What's New in Version R5.1a?
December 12, 2003

Enhancements:
-------------

1. Added support for new devices: SNAP LCE controller, and SNAP Simple I/O
brain.

2. Added support for PID Loops for the SNAP Ethernet devices that have added
that new feature.

3. Added support for OptoControl variables - Integers, Floats, Strings, and
their corresponding table types.

4. Scratch Pad Bits can now be accessed on SNAP Ethernet brains.

5. The extended Scratch Pad Integers and Scratch Pad Floats areas on Ultimate
I/O can now be accessed by the exact index of the element.

Bug Fixes:
----------

1. Updates of array elements in the upper portion of the array would not
always occur at the proper time.

===============================================================================
What's New in Version R5.0b?
August 22, 2003

Bug Fixes:
----------

1. Attempting to load Browser Items files that resided in very long pathnames
would result in strange and unpredictable behavior in the Browser Configurator.

===============================================================================
What's New in Version R5.0a?
July 28, 2003

Enhancements:
-------------

1. Added support for Ultimate I/O brains and controllers.

2. Added a Browser Configuration utility that gives greater control of the
tags that are available in the OPC Server's browser interface.

Bug Fixes:
----------

1. Performing asynchronous writes using the older IDataObject interface would
result in memory leaks.
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2. When removing a group, the corresponding data callback interface would
sometimes not be released in the correct order, resulting in the server hanging.

3. When the server was remotely activated and a second client would connect,
the server would crash if the log view was being written to. In this situation,
the server is invisible and there is no need to write to the log view.

4. Changed the initial quality of items that haven't been scanned yet to "Not
Connected" instead of "Bad".

5. When items were added to an inactive group, the group would be marked as
active after the operation of adding items.

6. The server would crash if there was no group selected in the user interface
and the Show Items menu item was chosen.

7. In AsyncIO::Read and AsyncIO::Write (as opposed to AsyncIO2::Read and
AsyncIO2::Write), the server is supposed to return S_FALSE when any of the item
handles are invalid. Also, no transaction should be queued up at this point.
These functions were behaving like their AsyncIO2 counterparts which allow some
item handles to be invalid and the remaining items would be included in a
transaction that would result in a callback.

8. The number of lines displayed in the message log has now been limited to
prevent overflows that could in some situations cause a memory leak.

===============================================================================
What's New in Version R2.0b?
November 14, 2001

Bug fixes:
-----------

1. String array items were being updated at every subscription interval
instead of only when there was a change in the string data.

2. IOPCShutdown could not be Advised by clients meaning that this interface
was not available to clients.

3. Using Generic Tags to specify access to memory map information would result
in mixed up results (e.g. information for the second tag would be returned for
the first tag).

4. Writing to the Scratch Pad Bits area of the memory map was not working
correctly.

5. Transferring BSTR and all SAFEARRAY data on IDataObject (ver 1.0)
subscriptions did not work correctly.

===============================================================================
Windows NT Installation Notes:
-----------------------------

Windows NT users must have write access to the registry and the WinNT\System32
directory to successfully install and use this product.
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===============================================================================
Uninstallation of this Product:
------------------------------

A utility is provided to uninstall this product. The utility will remove all
registry entries and files previously installed with the following exceptions:
  - The installation directory tree is not removed if any user-created files
  exist in it.
  - The Win95/Win98 program folder or Windows NT program group is not removed if
  any icons have been added by the user.

ioManager
What's New in Version R7.1c?
December 11, 2006

Bug Fixes:
-------------

1.   (KB51899) A problem has been fixed where Filter Weight, and Fast Settle 
Level for Load Cell modules were not being configured correctly in Inspect mode.

2.   (KB53373) Calibration of analog input points now works as expected.
Improved the feedback to the user when something goes awry.

3.   A problem has been corrected where Configuring SNMP Trap Version was 
possible for all I/O Unit types when it should have only been possible for 
certain I/O Unit types.

4.   Changed labeling of SNMP v2 Notification to SNMP v2 Trap.

What's New in Version R7.1b?
===============================================================================
May 18, 2006

Enhancements:
-------------

1. (KB51463) Added the ability to synchronize the device time to the PC time 
after a firmware install.

2. Changed references to IP Ports to just Ports, and IP Security to Network
Security.

Bug fixes:
-----------

1. (KB51648) An error is no longer reported when reading an empty flash memory 
image on SNAP-PAC-R1 and SNAP-PAC-R2.

2. A problem has been corrected where the Point Config Inspect mode dialog was 
not setting Load Cell Filter Weight and Fast Settle Level correctly.

3. The Read Filenames From I/O Unit command on the Maintenance dialog no
longer returns the wrong time for each file.
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4. A problem has been corrected on the I/O Unit Import/Copy dialog where the 
primary ip address was getting duplicated into the ip address list of the Edit 
I/O Unit dialog when the Image Destination was to Create a New I/O Unit.

5. The SNMP Trap Version - Notification is no longer causing an error to be 
reported when configuration information is sent to a SNAP-B300-ENET.

What's New in Version R7.1a?
===============================================================================
March 8, 2006

Enhancements:
-------------

Added support for SNAP-PAC-R1 and SNAP-PAC-R2.

Bug fixes:
-----------

(KB50210) A problem has been fixed where occasionally the Test Ping on the 
Assign IP Address dialog would just flash the screen instead of pinging the 
device.

What's New in Version R7.0d?
===============================================================================
February 2, 2006

Enhancements:
-------------

1. PPP Commands in the PPP Status Inspect mode dialog can now be used with
UIO and LCE devices.

2. Control Engine port has been added to the IP Security Inspect mode dialog.
The default value is 22001. A value of 0 will disable the control engine.

3. Trap Version has been added to the SNMP Agent configuration. v1 Trap and
v2 Notification are the supported settings.

4. An informational dialog is now displayed before attempting to install
firmware via a serial connection.

5. The Previous Command info has been removed from the Status Read page.

6. All Compatible File Types is now the default mask when installing firmware
on the Maintenance dialog.

Bug fixes:
-----------

1. (KB50639) A problem has been fixed where the Current Value of Input and 
Current Value of Setpoint items in the PID Loops Inspect mode dialog were not 
displaying the correct values.
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2. (KB50638) A problem has been corrected where extremely high counter values 
were being displayed as negative numbers in the Inspect mode Digital Point and 
Digital Bank dialogs.

3. (KB50636) A problem has been corrected where access was being denied to 
Inspect mode PID Loops dialog for EIO firmware versions 6.1 to 6.1c.

What's New in Version R7.0c?
===============================================================================
November 11, 2005

Enhancements:
-------------

1. Increased Scratchpad Floats and Integers by 7168 to 10240 elements.

2. Added PPP Commands to the PPP Status Inspect mode dialog for the SNAP-PAC.

3. Added the ability to access Comm Port Control data for the 3rd serial port
on SNAP-PAC controllers.

4. Added the ability to set the Secondary Interface IP information on
SNAP-PAC controllers to the Status Write Inspect mode dialog.

What's New in Version R7.0b?
===============================================================================
September 29, 2005

Enhancements:
-------------

1. SNAP-AIMA2-i, SNAP-AIVRMS-i, SNAP-AIARMS-i modules now supported.

2. Added the ability to copy information to the clipboard in the Find Opto 22
MMP Devices dialog.

What's New in Version R7.0a?
===============================================================================
July 28, 2005

Enhancements:
-------------

1. The Assign IP Address dialog box now supports DHCP devices such as E1 and
E2 brain boards as well as BootP devices like EIO and UIO.

2. Added the ability to find all OptoMMP (memory-mapped) devices on the
network and list their MAC and IP addresses, firmware versions, and types.

3. Added the ability to use Host Names instead of IP Addresses in Inspect
mode. Host Name and Domain Name were added to the Status Write dialog box.

4. Load Cell (SNAP-AILC), Profibus (SNAP-SCM-PROFI), and SNAP-AOA-23-iSRC
modules now supported.
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5. Added Scanner Flags setting to the Inspect mode Status Write dialog box.
       1 = process alarms in digital scanner
       2 = stop analog scanner
       4 = stop digital scanner
       8 = stop control engine

6. 32 PID Loops now available on SNAP Ultimate I/O Units with analog
capability.

Bug fixes:
-----------

1. IP Addresses that were very similar could sometimes be incorrectly
resolved in Inspect mode. Now each IP Address has a port and timeout
associated with it.

2. When installing new firmware in the Maintenance dialog box, ioManager
now confirms that the device has restarted after the firmware is installed.

3. "Save to Flash" is now the default in the Send Configuration dialog box.

4. SNAP-AIRTD module now has a generic resistance mode point type.

===============================================================================
What's New in Version R6.1a?
March 1, 2005

Enhancements:
-------------

1. Added support for High Density Digital Input and Output modules.

2. Added "Is Event Occurring?" flag to the memory map for Digital Events.

3. Added items to the Status Read dialog for diagnostic purposes:
       TCP Idle Session Timeout Count
       Arcnet Transmit Attempts Since Powerup
       Arcnet ACKs
       Arcnet Timeouts
       Arcnet Other (node not found, etc
       Arcnet Timeout Value (msec.)
       Arcnet Receive Interrupts
       Digital Interrupt Failures Since Powerup

===============================================================================
What's New in Version R6.0b?
January 17, 2005

Bug fixes:
-----------

1. PPP Incoming Password string in Configuration Mode is now being written to
the correct memory map address.

2. PPP Modem Initialization strings can now have embedded commas.
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===============================================================================
What's New in Version R6.0a?
October 1, 2004

Enhancements:
-------------

1. Added hotkeys to the Turn On and Turn Off points in the Inspect Mode
Digital Point dialog box.

2. Clarified menu options for installing firmware via Ethernet or serial
connection.

3. Organized common communications into one button in Inspect and in
Configuration modes.

4. Added Timeout fields to the I/O Unit Import/Copy dialog.

5. Modified the Modbus Address Conversion graphic to make it easier to
understand.

6. Added Milliseconds Since Powerup, Ethernet MAC Resets Since Powerup, and
Digital Output Points Resets Since Powerup to Inspect Mode Status Read dialog.

7. Inspect Mode now remembers the Timeout setting.

Bug fixes:
-----------

1. Scratch Pad String Inspect dialog box now guards against invalid length
values.

2. Installing firmware to multiple devices in the Maintenance dialog no longer
results in an erroneous "Could not open local file" log message.

3. The Inspect Mode Point Configuration and Analog Point dialog boxes now
display all AIPM module channels correctly.

4. ioManager will now allow you to save an empty file, including a file from
which all I/O units have been deleted.

5. ioManager is now stable when reading OTG files with Digital Events.

6. You can now write to the PID module data in Inspect Mode.

7. PPP Status - Status Result for LCE devices now returns the correct status
codes.

8. Data Logging Configuration in Inspect Mode now reads and writes to all
points correctly.

9. Changing the Point Type in the Point Configuration dialog box in Inspect
Mode now updates the scaling values, ensuring that subsequent calibrations to
the updated point are scaled correctly.

10. Connections with latency between ioManager and the device no longer time
out when attempting to read after a powerup.
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===============================================================================
What's New in Version R5.1c? 
April 27, 2004

Enhancements:
-------------

1. Added Sync I/O Unit to PC Time feature to the Maintenance dialog.

2. Added SNAP-pH/ORP analog input module.

3. Modified the Modbus Address Conversion picture to make it easier to
understand.

Bug fixes:
-----------

1. All 128 digital events can now be accessed on ENET-D64, UP1-D64, and UP1-
M64.

2. The memory map location of Incoming PPP Password is now F03E60B0. The PPP
Phone Number can now have embedded commas and the Link Always Connected setting
is now being saved to disk correctly.

3. The AIV2-i and pH/ORP modules did not display proper choices for Point Type
in Inspect Mode.

4. The main window will now remember its size and position.

5. All Event Dialogs in Inspect mode are now properly disabled when accessing
SNAP-LCE.

===============================================================================
What's New in Version R5.1b?
December 18, 2003

Bug fixes:
-----------

1. Serial Module Parity in Inspect mode can now be set to Even with- out it
switching back to Odd when the Apply button is pressed. Also, added Mark and
Space to the list of parity choices.

2. The Modbus memory map address calculator now correctly supports the full
range of memory map addresses as shown in the picture.

===============================================================================
What's New in Version R5.1a?
November 14, 2003

Enhancements:
-------------

1. Added Configuration and Inspect dialogs for PID Loops.

2. Added support for Simple I/O (SNAP-ENET-S64).
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3. Added Configuration and Inspect dialogs for M2M functionality.

4. Current Local IP Address was added to the display of PPP Status.

5. Login and Password strings in PPP Config were lengthened to 64 characters.

Bug fixes:
-----------

1. Serial Module Config no longer clears the Hardware Flow Control byte.

2. The extended Scratch Pad areas for Integers and Floats now have the correct
MemMap addresses in the Configuration and Inspect dialogs.

===============================================================================
What's New in Version R5.0b?
September 15, 2003

Enhancements:
-------------

1. Added Flash Tech Config and Status dialogs.

2. Added M2M section to Event Messages Inspect dialog.

3. Scratch Pad Floats and Integers expanded to 3072 items from 1024 items.

4. Switch To Loader Mode command added to Status Write dialog.

5. Improved Maintenance Dialog to be resizable, have colored text in the
results list, and to copy a portion of a result line to the clipboard.

6. Added Ethernet Physical Link dialog.

7. In Inspect Mode, added "used" markers in the event/message number combo box
to indicate which events/messages are currently configured.

Bug fixes:
-----------

1. Commas are now stripped from Point Descriptions as they are written to
disk.

2. Alarm Events, Digital Events, Serial Events, Timers, Wiegand Events, Event
Messages, Serial Modules, Wiegand Modules, Point Config, PPP and Status Write
handle partial reads/writes of the memory map.

3. The Maintenance Dialog no longer allows duplicate IP Addresses, and the Copy
button is correctly enabled when a result line is selected.

===============================================================================
What's New in Version R5.0a?
July 30, 2003

Enhancements:
-------------
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1. Added the ability to configure Analog Events, Digital Events, Serial
Events, Timer Events, Wiegand Events, Wiegand Modules, PID Modules, Scratch Pad
Bits, Scratch Pad Integers, Scratch Pad Floats, Scratch Pad Strings, IP
Security, Date and Time, Data Logging, Modbus, Status Write, and Wireless I/O
Unit.

2. Added "Inspect Mode" which gives the ability to inspect and/or change any
memory mapped value on an Ethernet I/O unit that can be reached over an Ethernet
connection.

3. Added "Maintenance Mode" which gives the ability to perform various
operations on one or more Ultimate I/O units. Operations include Install
Firmware, Install Module Firmware, Upload File, Down- load file, Read Files From
Flash, Write Files To Flash, and Clear Flash Files.

4. Added the ability to change the IP Address, Subnet Mask, Gateway Address,
and DNS Address of an Ethernet I/O unit.

5. Added support for the SNAP-UP1-M64 I/O unit which allows analog and digital
I/O on all 64 points.

Bug fixes:
-----------

1. Ultimate I/O D64 brains were not being recognized when trying to read flash
memory images.

2. Changed the way that the address for where the Flash Memory Image begins is
determined. Removed reliance on reading the unit type.

===============================================================================
What's New in Version R1.0c?
September 12, 2002

Enhancements:
-------------

1. Detailed error and diagnostic messages are reported when an I/O Unit image
is sent using the I/O Unit Import/Copy dialog.

Bug fixes:
-----------

1. Some strings were not being null terminated correctly when sent to an I/O
Unit. All strings in the memory map have a specified maximum length, so the
strings must be truncated to one less than that maximum length to allow for a
trailing null character. The problem could only occur on strings that were
longer than the field length. Point Name, FROM E-mail Address, TO E-mail
Address, E-mail Subject, SNMP Community string, and SNMP Host Community string
were all incorrect. SNMP Sysname, SNMP Syslocation, and SNMP Syscontact were
actually being truncated to 16 bytes when the field is 32 bytes. Modem
Initialization string, Modem Hangup string, Incoming Login, Incoming Password,
Modem Listen string, Outgoing Login, Outgoing Password, and Phone Number were
technically incorrect but their lengths were being handled properly in the
ioManager dialogs so it was highly improbable to have an error with these
strings.
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2. When sending I/O Unit images to Ultimate I/O units, an error occurs if
there are modules that exist in the image that are not present on the I/O unit.
This error was causing the operation to be aborted. Now, the operation
continues, and errors are logged and displayed at the end of the operation.

3. When reading an I/O Unit image from a file, the number of characters to be
read in was not being checked against the number of characters that were
actually read in. If these two numbers are different, it indicates a corrupt I/O
Unit image file. This error is now reported.

4. The I/O Unit Import/Copy dialog would sometimes allow the Create I/O Unit
radio button to be selected even though other choices on the dialog had disabled
that button.

===============================================================================
What's New in Version R1.0b?
November 12, 2001

Bug fixes:
-----------

1. Removed calls that were causing computers without Microsoft Office
installed to display error messages when reading and sending brain images.

2. Changed how analog point information is sent. No scaling is sent for non-
scalable points. Gain and Offset are no longer sent since it might wipe out
previous calibration.

3. Fixed PPP Configuration strings, which were not being cleared correctly
before being initialized by ioManager. This resulted in random characters at the
end of strings in the PPP Configuration.

4. Gateway and DNS addresses were not being sent correctly to Ultimate I/O
brains in the Assign IP Address dialog box.

===============================================================================
Windows NT Installation Notes:
-----------------------------

Windows NT users must have write access to the registry and the WinNT\System32
directory to successfully install and use this product.

===============================================================================
Uninstallation of this Product:
------------------------------

A utility is provided to uninstall this product. The utility will remove all
registry entries and files previously installed with the following exceptions:

- The installation directory tree is not removed if any user-created files exist
in it. - The Win95/Win98 program folder or Windows NT program group is not
removed if any icons have been added by the user.
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ioUtilities
What's New in Version R7.1c?
============================

May 18, 2006

ioCom.dll is now version R7.1c

1. (KB50320) Corrected a problem in the View Messages dialog. Incorrect results 
would be shown if a chart's name was longer than 35 characters.

2. In the Inspecting Control Engine dialog, added a field to show how many 
charts are currently running.

What's New in Version R7.1b?
============================

April 7, 2006

(KB51140) OptoVersion was updated to include ioProject Professional and Basic 
executable files.

What's New in Version R7.1a?
============================

February 15, 2006

(KB49973) Corrected a problem that could prevent OptoENETSniff from loading a 
log file, instead reporting the error: "Invalid Log File Error Type mismatch; 
Error in function LoadFile. Invalid log file. Error code 13."

What's New in Version R7.0b?
============================

January 19, 2006

1. When using one of ioTerm's command line options, it now returns an 
error code to indicate success or failure. It also provides a -q option
to prevent any dialog boxes from being shown.

2. In the Inspect Control Engine dialog box, added user confirmation
to the Run and Stop buttons.

What's New in Version R7.0a?
============================

December 11, 2005

1. ioTerm now supports the secondary network interface found on SNAP PAC
products.

2. ioMessageViewer is now more responsive when logging to a file and the
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screen at the same time.

What's New in Version R6.0a?
============================

October 1, 2004

1. ioTerm no longer includes the Clear ioDisplay Words option, which
is obsolete for ioDisplay versions R5.1 and newer.

2. ioMessage Viewer (formerly ioSnif.exe) now supports logging to multiple
files.  Multiple files can be helpful when sniffing for longer periods of time.
Filenames are automatically generated and stored in a subdirectory based on the
date and time logging begins.

3. ioMessage Viewer now allows you to disable on-screen updates while logging.
Disabling on-screen updates reduces the resource usage so the sniffing itself
will have less impact on the behavior you're recording.  See File->Settings.

4. OptoEnetSniff is now included as part of ioUtilities for the R6.0a release.

OptoEnetSniff R6.0a Enhancements
--------------------------------

* Added an option in OptoEnetSniff to specify the number of buffers to save (as
a file to the hard drive).  This avoids unintentional overwriting by creating a
folder for the new multiple files created.  Folder and files are named according
to time and date.  (Example:
2004.09.01_09.48.45\netmon2004.09.01_09.48.48-2.log)

* Increased allowable buffer size to 256 MB.

* Now OptoENETSniff remembers your preferences for adapter card selected,
display colors, and buffer settings.

* Added menu keyboard shortcuts for easier navigation without a mouse.

* Increased the maximum number of characters in the Name field to allow IP
addresses to be used as names.

* The adapter selection is more flexible.  It will now allow the user to select
a 0.0.0.0 IP address.  (0.0.0.0 appears as "unknown.")

OptoEnetSniff R6.0a Bug Fixes
-----------------------------

* Corrected bug that caused the application to crash when no IPs were selected
for filtering.

* Adapter card information is now read more reliably.

* Corrected red error indicator that incorrectly appeared in logs opened after

README: ioProject 7 50



a log with an error.  The indicator incorrectly showed up on the same row as
the previous log's error, even though no errors occurred on the frame in the
new log.

* Corrected bug that sometimes occurred after clicking the Stop Capture button.
The bug caused the message "Error in function Loadfile. Invalid log file. Error
code:9" to appear.

* Corrected bug that sometimes occurred if the Stop Scan button was clicked
while attempting to capture packets.  The bug caused the message "Error in
function Loadfile. Invalid log file. Error code: 0" to appear if no packets
were captured.

What's New in Version R5.0a?
============================

July 29, 2003

1. ioTerminal displays the date, time, and strategy object associated with any
error or notification message.

2. ioTerminal no longer includes the Clear ioDisplay Words option, which is
obsolete for ioDisplay versions R5.1 and newer.

What's New in Version R1.0c?
============================

August 16, 2002

1. Each line in an ioMessageViewer log now has a unique line number.

2. Added filtering to ioMessageViewer.

3. In ioMessageViewer, the client's name is now included on each line.

4. Added a timestamp to mark when logging to a file has started or stopped.

5. Added support to ioTerminal for ioControl's new Control Engine Download File
feature.

6. Added command line arguments to ioTerminal for adding a control engine,
downloading a file, and running and stopping a strategy.

7. Made a few GUI tweaks to make ioTerminal easier to use with a keyboard. The
control engine inspect dialog now has a close button that is the default. Also,
selecting a control engine and hitting Enter will now open the inspect dialog,
rather than closing ioTerminal.

What's New in Version R1.0a (002)?
==================================

September 7, 2001

1. The "Inspect Control Engine" dialog in ioCom.dll has a new look. It also has
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two new fields, "Revision Time" and "Persistent RAM".

2. The "Inspect Control Engine" dialog in ioCom.dll now uses a different method
for determining the communications loop time. It now displays the time taken for
one single transaction, rather than several.

3. OptoVersion was not scanning directories that had the archive, hidden,
compress, or hidden flags set.

===============================================================================

What's included in ioUtilities?
===============================

ioTerm.EXE, ioMessageViewer.EXE, OptoVersion.EXE, AND OptoENETSNiff.EXE

ioTerminal (ioTerm.exe)
------------
ioTerminal.EXE may be used to create and test communications to control engines.
When it starts, it displays a list of control engines configured on your
computer. ioTerminal is used to:
* view a status dialog for a control engine
* interactively 'talk' to a control engine for diagnostic purposes
* add and configure control engines

ioMessage Viewer (ioMessageViewer.exe)
------------
ioMessage Viewer is used to monitor communications at various levels in the
communications drivers. Normally, ioMessage Viewer is used with the help of Opto
22 Product support personnel. Select 'View/monitor levels' to enable or disable
various monitor levels.

OptoVersion.EXE
---------------
OptoVersion is a quick utility that will come in handy when you are talking with
our Product Support staff. OptoVersion searches your local hard drives and
reports back all the Opto 22 DLL and EXE files that you have, including their
versions and paths. If Product Support needs to see the list, the utility sets
it up for easy emailing.

OptoEnetSniff.EXE (OptoEnetSniff.exe)
------------
OptoENETSniff is a network communication analysis tool that captures Ethernet
frames and stores them in a log for analysis. You can capture a log manually or
use an automatic timer. Additional features are:
* Advanced Scripting for Visual Basic users.
* Display options
* Tracing routes

How to Get Help
If you have any questions about this product, contact Opto 22 Product Support
Monday through Friday, 7 am to 5 pm, Pacific Time.

Email: support@opto22.com
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Phone:  800/TEK-OPTO (835-6786) 951/695-3080

Fax:    951/695-3017

Bulletin Board (BBS) available 24 hours a day, 7 days a week): 
– via the Internet at http://bbs.opto22.com
– via dialup modem at 951/695-1367 

When accessing the BBS  via dial-up modem, use the following modem settings:
  - No parity, 8 data bits, 1 stop bit
  - ASCII or ANSI display protocol
  - Baud rates up to 28,800
  - Z-modem protocol for uploads and downloads

Please provide the following information about your system to the Product
Support engineer:

  - Version of this product
  - PC configuration (type of processor, speed, memory, operating system)
  - A complete description of your hardware system, including:
    - jumper configuration
    - accessories installed (such as daughter cards)
    - type of power supply
    - types of I/O units installed
    - third-party devices installed (e.g., bar code readers)
    - Controller firmware version
  - Any specific error messages seen

=====================================================================

Visit our web site at http://www.opto22.com

=====================================================================
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